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Microsoft Publisher 2003
WELCOME!
Information Technology Division (ITD) – http://itd.ncsu.edu 
Computing Services (CS) - http://www.ncsu.edu/it/essentials 
Computing Services Workshops - http://www.ncsu.edu/it/education/ 


Instructors:

Jen Riehle: Jen_Riehle@ncsu.edu

Twanda Baker: Twanda_Baker@ncsu.edu


 

Objectives:

1. What is Publisher?
2. Starting work with Publisher

a. Using the New Publications Wizard

b. Publications by Print

c. Design Sets

d. Blank Publications

3. Using the Publications Options

a. Publication Options Pane

b. Creating a Color Scheme

c. Design View

4. Publications Structure

a. Adding to you Publication

b. Using Objects

c. Layering Objects

d. Grouping Objects

5. Connecting Text Frames

6. Publication Layout
a. Background

b. Using Tables

c. Formatting Pictures

7. Creating a Website

8. Printing with Publisher

To begin, please find the Publisher folder.

Double-Click My Computer (The computer icon your desktop)

Double-Click the "I:/" drive
Double-Click “Publisher”.

* You may choose to copy and paste the folder to your desktop for easier access.
What is Publisher?

Publisher is a Microsoft Office Application used for creating everything from brochures to business cards. It allows you to quickly and easily select a design and apply it to one of many layout templates. Publisher also allows you to change the layout, design and color of your publication to fit you needs.
Publisher, which has not been updated for several years, received a face-lift before being rolled out with Microsoft Office 2003. Though the look has changed some, the basic features and functions of Publisher 2003 remain extremely similar to previous versions.
Starting Work with Publisher

To open Publisher in the Unity environment, just go to your Novell Application Launcher, and look under “Office Applications”, within the “Unity Applications” folder. There you will find an icon for Publisher 2003. To start, double-click on the icon.
If you are trying to access Publisher from home, go to the “Start” menu, then “Programs”. Under Microsoft Office, you should find Publisher. Click once.

Using the New Publications Wizard
When you open Publisher you will always first see the ‘New Publications’ window. 
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This screen has options for opening existing documents as well as dozen of options for types of new publications you would like to create. The left hand column separates the new design options into four categories:

· Publications for Print

· Web Sites and E-mail

· Design Sets

· Blank Publications

At the bottom of the column, there is a button to open existing files, new publications and new web pages.
Publications by Print

The ‘Publications for Print’ is by far the largest section. This group includes the following types of documents:
	Quick
Publication
	Flyers
	Brochures
	Newsletters
	Web Sites

	Invitations
	Envelopes
	Calendars
	Banners
	Advertisements

	Business Cards
	Personal Cards
	Gift Certificates
	Award Certificates
	Programs

	Greeting Cards
	Postcards
	Airplanes
	Origami
	Menus

	Business Forms
	Letterheads
	Labels
	Catalogs
	Resumes


Users have even more choices than these. By clicking on the triangles to the left of each group, the user can see all the different types of publications included in each group. For example, under the “Business Forms” option, the user has all of these types of documents to choose from:
	· Expense Report

· Fax Cover Sheet

· Inventory List

· Invoice

· Purchase Order
	· Quote

· Refund

· Statement

· Time Billing

· Weekly Record


Unlike previous versions of Publisher, ‘Websites and E-mail’ are also an option in the new Design window. We will review making web pages with Publisher later in this document.
Design Sets
The third section is for “Design Sets”. This section shows all the design templates available. Most of the designs can be applied to all of the different kinds of publications, though some may only be available to certain ones, such as calendars or business cards. The designs are referred to as “sets” because they can be applied to all the publications in a group (i.e. Letterhead, business cards, web page etc.). In this way, you can search for a design you would like to use for a series of publications, to represent your company or group repeatedly, rather than searching one type of publication for an appropriate design.
Blank Publications

The Blank Publications tab show several layouts that you can select and then begin to customize. These layouts include:
	· Full Page

· Web Page

· Postcard

· Business Card

· Book Fold 
· Side- folded card
	· Top- folded card

· Tent card

· Poster

· Banner 

· Index card


Please note that when a design that is clicked on it will automatically be created and opened in a new window. Make sure the selected design is your final choice before clicking on it. 
Using the Quick Publications Options
Once you select a design and publication type, the catalogue will disappear and leave you with a basic layout. On the left is the Publication Options Pane, which will help you configure your publication. On the right, will be the publication itself, which can be configured as well.
Publication Options Pane
The options pane will offer you several design choices depending on the kind of publication you are working on. It will ask you to configure the color and font scheme, basic layout and personal information. Your personal information can be saved and retrieved for later publications. The personal information window allows the user to customize data for four separate “accounts”:

1. Primary Business
2. Secondary Business
3. Other Organization
4. Home/ Family

With each of these groups, you can specify a name, address, phone, fax and e-mail information as well as a motto for businesses. You can also associate each of these “accounts” with a color scheme, which will be automatically applied in various publications.
Creating a Color Scheme
If you would like to edit the color scheme associated with your presentation or personal information group, Go to ‘Format’ and ‘Color Scheme’. There you can view all the color schemes that are available. When you select one, you can preview your page with that scheme applied. 
	You should also look for a button at the bottom of the page that says: “Print Color Sampler”. This is a very good idea. Colors on your screen frequently look different when on paper, so if your publication is for print, be sure to test colors first.



You can also click on the tab at the top of the pop- up window that says ‘Custom’. There you can change the color for each of the options; the ‘Main’ color, five accent colors and two hyperlink colors. Preview your color choices for your publication on the right. Be sure to note the colors of the text to make sure that they are legible. Once complete, click on “Save Scheme” and make up a name for your scheme. It will appear with the other schemes in the Color Scheme Menu.
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Even after you have made all your selections for color scheme, font and layout, the pane will remain open on the left hand side of your document for quick access. This pane will remain open at all times unless you close it using the ‘X’ in the upper right hand corner of the pane. Next to the ‘X’, you will see a downward pointing arrow. When clicked, this arrow will display a list of all the types of panels that can appear in the left-hand pane, including the clipboard, clip art and search tools, new publication options and several font, color and background menu options. Publisher, starting with the type of publication and moving through the design and layout options, places these options in a certain “order”. To move through these choices, use the arrow keys on the far left hand side of the window.
At any point this pane may be closed, however, if you select one of these options form the Menu bar, this pane will reopen, and will continue to do so each time an option that appears in the pane is selected.
Design View

The view on the right half of the application (or the main view) is that of the publication you are working on. All the changes you can make with the wizard, you can make on your own in the design view; they just take longer to apply individually. For example, you can change the font in each text window individually, or you can change the font scheme so the text is automatically updated all text in all text boxes at once.

 Use the horizontal and vertical scrollbars to move within the main view. The canvas for your publication is much larger than the actual publication so you can move your display view around freely and store unused shapes and objects outside the printed area. 
Notice at the top of the page, on the taskbar, there is a percentage display. This shows you the amount of your image that you are currently viewing. You can zoom in or out by clicking on the “+” or “-“ sign, or by using the drop- down menu to select a magnification, 10% through 400%.
Some publications require designs and printing on the front and back of the document. When this occurs, the side of the document design that is hidden can be toggled using an icon at the bottom of the Publisher screen. For example, a brochure will display, [image: image20.png]


loosely sectioned off into thirds. To see the other side of what would be printed and displayed on the brochure, click on ‘2’, which represents the next page, or opposite side of the current page. Some documents, such as books, may even be larger and the pages will lie across the length of the bottom of the Publisher window.
Publications Structure

Almost everything in the design view sits in its own box, called a frame. You can make changes to that frame by clicking on it. For example, to change the text in a frame, double click somewhere within the frame and then select the text to remove and type what you would like. 
The frame you are working on is marked by hollow circles outlining the corners and mid- points of the selected frame. To change the size or shape of the frame, move your cursor over these black squares. Your mouse should change to look like small arrows, which will indicate which directions you can move or expand the frame into.
Adding to your Publication

Once you have created and customized your publication you may find that more is needed. Alternately, if you are starting from a blank publication, you will need to add all the content you would like. 

Along the left hand side of the page, you will find a toolbar of useful buttons. Each of the icons on this toolbar can add to your publication by inserting a frame for the type of content indicated. These icons include:
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	Allows the user to select objects. This is the default button and the one with which we move and resize the frames.
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	Allows the user to add a text frame anywhere on the page.
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	Used for inserting tables, and displays a menu to customize the input.
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	This tool is for controlling and creating WordArt. You can type whatever you want and change the angle, shape, shadowing, etc.
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	This tool allows the user to insert an image from file, scanner or camera, a piece of clip art or simply a blank frame.
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	Add a line to your publication
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	Add a line with an arrow (at one or both ends) to your publication
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	Add a circle or oval to your publication
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	Add a square or rectangle to you publication
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	Add a custom shape to your publication (smiley face, heart, triangle, callout, flow chart)
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	You can also add different kinds of objects. For example, calendars are available from the Design Gallery Objects Menu, along with flags, coupons, advertisement, sidebars, captions and more.




Using Objects

The objects added to your publication can all be adjusted using tools available on the “Formatting” and “Standard” toolbars shown at the top of the screen. Objects can include text boxes, various shapes or large groups of objects that can be managed, such as calendars. Using the following tools, you can adjust the layering of objects, rotate the objects or format the objects.
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	This button free rotates the selected object. To rotate the object by a controlled amount, or to flip the object horizontally or vertically, click and hold down the arrow on the right and choose from the menu.
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	All objects are layered. It may not be clear at a given point which image is on top, but if you would like to change the order, you can do so by clicking on an object, and using one of the buttons in this drop down menu. To see the full list of options, click on the arrow to the right.



Anytime an object is selected, you can right-click and choose to format the object. This will show several options including options for adjusting the layout of the text, the coloring of the photos and border of the object boxes.
Layering Objects
To move the selected objects forward or backward in the layer order you can use the tool mentioned above or go to the “Arrange” menu. This menu has options for “Bring Forward” or “Bring Backward” which will move the object one layer at a time. There are “Bring to Front” and “Bring to Back” options as well which will move the selected object to the top of the layers or send it to the bottom. 
You may notice that sometimes when you place text or shapes over other objects, the objects may be blocked by a color: the background of the object on top. You can create a transparent background for any text or shape by going to “Fill” option and selecting “No Fill” or by simply clicking ‘Ctrl-T’.
Grouping Objects

Sometimes in the process of creating a publication, you may create a series of objects that you would like to repeat, or move together. For example, if you are creating a logo or picture that you would like to use again, you can “group” the objects that are a part of that logo. Once you have the objects in place use the arrow button to create a square around all the objects you would like to use. Unlike the shape tool, the grouping square is gray, not black. Once you have completed the selection of the area, you will find a button at the bottom of the box.
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	Click this icon to lock selected objects as a group.
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	To ungroup already grouped objects, click the button again. When shapes are grouped, the icon will look like this.


Once grouped, you can move all the object together as well as copy, paste and cut them as a group.

Connecting Text Frames

When there is a large amount of text to be added to a page, it is sometimes necessary to rearrange this text to fit properly onto your publication. All text placed in a publication will be put into a frame. 
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If the text to be added does not fit into the frame, Publisher will display a small symbol at the bottom of the frame:

At this point, you can make room for the overflow text in one of two ways. First, you can enlarge the size of the current frame. Second, you can add a new frame. If you choose to add a new frame, you will have to manage the text in the original frame and move it to the new frame. Publisher will help you with this. Select the frame with the overflow text. Go to “Tools” and click on “Link Text Frames”. This will place the leftover text into a new blank frame (make sure you have a blank frame created before you do this). You can also use a button on the toolbar to connect the frames (left).
[image: image24.bmp]Once you have chosen to “link” the text boxes you will see a small icon like a lemonade pitcher. This will tip and “pour” the leftover contents of the previous text box into the new one once it is clicked on.
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You may eventually want to disconnect the text boxes with the contiguous text. If so, simply click on the text box in which you began the link and use the “Break forward link” button. 
As needed you can connect additional frames with more continuous text. Publisher calls this a “story”. Keep in mind that these frames can be adjusted, even after being connected and the story will move within the frames to fit the changes.
Publication Layout

The user has choices regarding the basic layout of the publication. The layout guidelines of a publication, if they exist, can be seen by going to “View” and then “Go to Background”. Most templates for publications have no layout set, so you can add them if you would like. This will not constrain your publication, but can be useful as a guideline for other who you would like to use the same general layout, or for future publications.

The user can create or change layout guidelines for a publication by going to “Arrange” and then “Layout Guides”. This will allow the user to decide on how many rows or columns to include. If the rows or columns need to be moved up and down, right or left, the user will need to make numeric margin changes to the pop-up window. These changes can only be made from the “Background”. Once done with the layout changes, be sure click ‘Ok’.

Background
One of the options in the left hand menu (and under ‘Format – Background’) is for a background color or pattern scheme. These will fill the background of your publication with either an image sized to fit the background (usually a gradient) or a smaller repeating image. These often add a nice level of contrast, or add texture to a smaller publication, like a business card.
	When applying a background, consider your document. If you have a larger document, will the repeating image be obvious and overwhelming? If you are not using a high quality printer, will your gradient look smooth and clean or choppy and pixilated? These issues are very important ones for consideration when trying to create a professional looking publication.



Using Tables

When the table tool is used, the user can select a general area for where they would like the table to go. They can then specify the number of columns and rows they would like, as well as several custom formatting options. Other formatting changes can be made with the toolbar.

By default, the gridlines that define the table will not show on the printed version. In order for these to show up, use the formatting tools for Line Styles. In addition, changes can be made to the width and height of the table rows and columns. Do this, select the whole row/ column and adjust as desired.
Other changes can be made including the border and line designs. Go to the “Border Styles” button on the task bar and select “More Styles”. You should see a pop- up window that includes a tab labeled “Border Art”. Here you will find dozens of options for border designs (both for your table and for other borders). You can also format the table by changing the fill colors, fonts, font colors etc.

Formatting Pictures

By default, when an image is added to, or placed with a text frame, the text will wrap around that picture to fit the defined area. If the area is too large or needs to be redefined with a larger or smaller margin, changes can be made by going to “Format”, then "Picture” and choose the ‘Layout” tab. This will allow you to change the way the text wraps the picture. Rather than following the defined edges of the picture, the text can wrap around the edges of the actual image. You can also set a buffer of space between the text and the image.
Another useful Picture option is in the same menu. Use the ‘Format’ menu (or right click) and choose format picture. There should be an option called “recolor”. This option will let you select only one color to apply to the whole picture. This color will be applied in various shades across the spectrum of the picture. In this way, a user can limit the number of colors to be used in a printed document, which is often a requirement to save on printing costs.
Creating a Website

Within the publications wizard this is an option for creating a website. When that option is selected, you will get a layout that appears to be a very long publication. You can also change an existing publication into a web page by clicking on the “Convert to Web site” link in the wizard of any publication (in the case of a website, that option is “convert to Print”). 
The “Web Site Wizard” has options for customizing each of the following:
	· Design 

· Color Scheme
· Form
· Navigation Bar
	· Insert Page 
· Background sound
· Background Texture
· Personal Information


The design and color scheme are the same as in any other publication. The “forms” option will allow the user to insert an order form, response form or sign-up form into the page. The “Navigation Bar” will give the user the choice for scroll bars vertically or both vertically and horizontally. 

“Insert Page” is an option to insert a new page. These pages are web page templates for things like lists, “story” layouts and calendars. When a new page is added, a link to it is automatically created on each of the other existing pages.
Under “Background Texture”, users can select a texture. This will take you to  pop- up window and when you use the “Browse- Background Textures” option at the bottom of the page you will find dozens of texture installed with Publisher and saved to the C:// drive. You can also find many animated images by inserting clip art, then clicking on the “Motion Clips” tab.
For more advance changes to the Publisher web page, look to the buttons on the side taskbar.
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	This button inserts hyperlinks into your web page.
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	This button has options for inserting form objects into the web page.

	[image: image18.bmp]
	This page allows the user to click on a section of the web page in order to add HTML code. This is useful for adding web counters, or other scripts or designs for personal additions.


It is important to mention that while this is one way to make a webpage it is not advisable. Publisher makes a very simple webpage without considerations for aesthetics, usability or accessibility. At a minimum, make sure that if you do use Publisher to create a webpage, that you keep a copy of the original file so you can edit the site in the future.

Printing with Publisher

Obviously, this is the ultimate goal when using Publisher. By going to “File” you have the standard “Print” and “Print Setup” options, but there is also a page setup option. This page gives the user a series of options for how to print:

· Normal
· Special Fold
· Special Size
· Labels
· Envelopes

With each of these, you can change other settings from the size of the paper or envelope or label, to the orientation of the publication to paper and special folds that need to be made (for example, for cards).

Here is an example of the screen and some of the options under the “Special Size” menu:
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When saving you may also notice a “Pack and Go” option. This will take all the files that are associated with your presentation, including fonts and images, and compress them, into one smaller file. The compressed files will be saved as a Publisher compressed file, with the extension ‘.PUZ’. 
	When publishing a document, be sure to speak with your publishing company to determine what format is workable for them. Some printers will want a compressed file such as the one mentioned above. Others may prefer files from a different publishing application. Many prefer the document in .PDF format.




Conclusion

The large volume of publication types, and the simplicity of the built in design schemes make this a very user friendly, if somewhat limited application. Always remember: when creating a document for print, to talk first to your printer. Make sure that your printer can handle personal jobs, or that you have met the requirements of any commercial printer you choose to use.

Good Luck!
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